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CHAPTER 1. ABOUT STITCH

Stitch!Advantages

Chapter 1

About Stitch

1.1 What is Stitch?

Stitch is a free1 program for making cross stitch designs that helps you create

and experiment with designs without many the problems that arises when

doing it on paper. After spending a little time with this manual you will be

able to use the program to create desings in a fraction of the time it would

take using more traditional techniques.

If you are new to Stitch you might wonder what advantages it has over

the traditional methods of doing cross stitch designs. It is a fair question,

and here is the answer. First of all, Stitch lets you do things that would

be diÆcult, if not impossible, using traditional methods. For example, you

can pick up any part of a design and rotate it or 
ip it to create its mirror

image.

Second, Stitch is just like a word processor for cross stitch designs. You

can move patterns from one part of the design to another, or you can copy

a pattern and paste it anywhere in your design. You can create a bouquet

of 
owers just by drawing a single 
ower and pasting it throughout your

design. In addition, you can make global changes to your designs with ease.

For example, if you decide that the blue border ought to have been red

instead you can make the changes for the entier design at one time.

Third, because you can save all your works on disk, you do not have to

create everything from scratch each time you work on a design. You can

thus build up a library of "clip art" patterns to use in future projects.

Finally, because you can print as many copies of the pattern as you like,

there need never be just one original of a design to lose or spill co�e on.

1Free in this context means free. You don't have to pay anything for it unless you want

to support the development monetary. If you want to give us money, by all means do so,

we most certainly won't complain. However, you can support us in other ways too. A

postcard or a letter (email is �ne too, but we like real mail) telling us what you think of

it would be nice. If you feel like sharing the patterns that you create with the program

that would also be nice.

1
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1.2 Contact Information

If you have any questions2 or comments you are welcome to contact us. The

easiest way to do this is through email: henrikbe@dsv.su.se

You can also write to us at the following address:

Henrik Bergstr�om

H�ogbergsgatan 63IV

118 26 Stockholm

Sweden

1.3 A Brief History of Stitch

The work on Stitch began in the autum of 2000 when my3 mother had

desided to create a "julkalender" to my at that time yet unborn nephew

Ossian. As soon as it is �nished I'll put in a picture of it here to explain

what it is, but for the moment we can be satis�ed with the fact that it is a

relatively large cross stitch pattern. Her �rst idea was to use Excel for the

task since she knew that program well. I on the other hand felt that there

must exist more specialized programs for it and promised to have a look for

something.

At that time I wasn't aware of the excellent resource that rec.crafts.

textiles.needlework is, so I searched program directories and search en-

gines on the Internet without much luck. Dead links and a couple of com-

mercial products that seemed far too overpriced was what I found. So, what

to do? I decided to write my own program, and a couple of weeks later Stitch

0.1 was ready for release. The rest is as they say history, and someday I

will muster enough energy to write some more on the topic. Stitch started

evolving, especially since I had began to realise what an excellent testbench

for new ideas the program was.

1.4 Known bugs and limitations

Like most software Stitch has room for improvements. This section lists

known bugs and limitations that are likely to a�ect your work with the

program. We are working on resolving all of them

� Limited undo/redo functionality. The undo/redo commands work �ne

with single stitches, but not that well for other typs of work.

� The settings for how a pattern is to be exported (e.g. if it should be

drawn will colored cells or with symbols) follows the patterns settings.

2You can �nd answers to common questions at the programs web site http://www.

dsv.su.se/~henrikbe/stitch
3Most of this maual speaks about "us" rather than "me" or "I". This is because several

other people has helped with the development of the program. However, the programming

and this manual is written almost exclusively by me, Henrik Bergstr�om, so I feel that I'm

entitled to a small personal ego trip here :-)

2
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Licence Agreement
� The help �les are hopelessly out of date. We have prioritated adding

functionality to the program. This manual should be up to date

though.

� The symbols isn't drawn exactly in the middle of the cells. We are

working on this one.

� Stitch types such as the quarter stitch and french knots would be nice.

Actually this is planned for inclusin in v1.3.

� Improved color similarity function for import and the similarity func-

tion would also be nice. Normally it works �ne, but sometimes it make

stupid errors.

� The symbol mode is too slow in redrawing the screen sometimes (es-

pecially when the sice of the cells are wery small).

1.5 Credits

� Lena { for wanting the program and lots of ideas for improvement

� Linda { for all the colors and help with improvements

� Carmen { for a spanish translation and lots of ideas

� Kerrie { for another spanish translation, patterns, and ideas

� Hasse { for the wonderful image that is used on the splash screen

� All users { simply for using the program which is a real ego boost, but

also for giving lots of comments and suggestions for improvement

1.6 Licence Agreement

We are no lawyers, but to make matters perfectly clear we have included

the licence agreement that you have to accept before installing the system in

the Appendix (page 47). What it say is basically that we own this software,

but you may use it as much as you like as long as you do not sell it or

try to claim any rights to it. It also says that although the program works

very well as far as we know, we will accept no responsibility whatsoever if

something goes wrong.
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Chapter 2

Installing Stitch

2.1 Getting Stitch

If you have not got Stitch already you can download it from: http://www.

dsv.su.se/~henrikbe/stitch

On the homepage you can also �nd more patterns and get help if you

should get any problems with the program.

2.2 System Requirements

The system requirements of Stitch is quite modest. Any PC that is capable

of running Microsoft Windows 95/98/NT/2000/XP/ME and has at least 5

megabytes of free harddisk space should be able to run the program. Note

however that Stitch might need large ammounts of memory, depending on

how many and how large patterns you are working with.

2.3 Installation Procedure

If you have downloaded Stitch from the homepage you will have a �le called

Stitch.zip. This is a so called zip-archive, i.e. a collection of �les that has

been packed together into a single smaller �le to save download time. Before

we can proceed with the actual installation this �le needs to be unpacked.

Exactly how this is done depends on your systems con�guration, but in

this document we have supposed that you have a program called WinZip

installed on your machine. If you do not have WinZip, and does not know

how to unpack zip-�les in another way we would recomend that you �rst

get WinZip. It is available on the Internet at http://www.winzip.com and

is usually included on computer magazine cd-roms and similar.

Now, double click on the �le Stitch.zip in the �le manager. This will

start WinZip which will look like one of the windows in Figure 2.1. The

top of these windows is called the classic interface, and if WinZip looks like

that the only thing you need to do is to double click on the line with the �le

install.exe and follow the on-screen instructions. If WinZip looks like the

5
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Figure 2.1: WinZip's Classic and Wizard Interfaces
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other interface (called the Wizard interface) we recommend that you click

on the button marked "WinZip Classic" and follow the instructions for that

alternative.

Now, if everything went allright in the previous step you will now �nd

Stitch on the Start Menu's list of programs.

2.4 Uninstalling Stitch

If you ever want to remove Stitch from your system you should do this

through the "Add/Remove Programs" program on the Control Panel. This

will ensure that Stitch will be completely1 uninstalled. Note however that

any patterns you have created will not be remove.

1There was a bug in the install program for v1.1 that installed a directory called

library
ags in the install directory. This directory can be safely removed if present. As

per v1.2 this bug has been �xed

7
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Chapter 3

A Quick Tour

When you �rst start Stitch you will see a system that looks like Figure 3.1

below except that there is no pattern loaded. As you can see the program

consists of four windows. The top of the screen is taken up by the main

window wich contains several parts. When you start using Stitch you will

probably only use the menu part of this window. However, when you have

gotten used to it you will undoubetly �nd the library more and more useful

as it allows you to store many patterns that you need to have quick access

to.

Figure 3.1: Stitch User Interface

Below the library window you see three windows: the tool palette which

contains the various tools that you can use to draw your pattern with, the

9
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Color palette
Main window

Main
window!Commands

Menu Commands

color palette that shows a subset of the colors you can use, and the actual

pattern window where you draw your pattern.

3.1 The Main Window

The various menues and buttons available in the main window is brie
y

explained in Table 3.1 through 3.7.

Item Short-

Cut

Btn Description

New Ctrl+N Creates a new blank pattern.

Open Ctrl+O Opens a previously saved pattern.

Reopen Displays a list of previously opened

patterns. Click on one of the patterns

to open it again.

Save Ctrl+S Saves the pattern. If the pattern has

not been saved before this command

works as the Save As command below.

Save As Saves the pattern to a new name.

Import Imports other types of images into

Stitch. This command allows you for

example to take a photograph of some-

one and create a cross stitch pattern

from it.

There is also an option here to im-

port text �les (ascii art). However, this

function is experimental and not doc-

umented, so if you want to use it you

are on your own.

Export Exports the pattern to a bitmap image.

You can also export the symbol legend

using this command.

Print Ctrl+P Prints the pattern.

Exit Alt+F4 Quits the program. If any of your pat-

terns has unsaved changes then you will

get a question about whether or not

you want to save it before you quit.

Table 3.1: The File Menu

10
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Item Short-

Cut

Btn Description

Undo Ctrl+Z Undoes a previous action to a pattern.

This feature is not �nished yet, so do

not rely too hard on it, save often.

Redo Redoes an action to a pattern that was

previously undone with the Undo com-

mand above. This feature is not �n-

ished yet, so do not rely too hard on it,

save often.

Cut Ctrl+X Removes a part of a pattern and places

it in a bu�er so that it can be inserted

at another place later using the Paste

command below.

Copy Ctrl+C Copies a part of a pattern and places

it in a bu�er so that it can be inserted

at another place later using the Paste

command below.

Copy to This command copies a part of a pat-

tern to a new �le

Paste Ctrl+V Inserts a previously stored pattern

(from the Cut and Copy commands)

into the pattern.

Flip Ctrl+Alt

+H/V

Flips the pattern, either horizontal or

vertical.

Rotate Ctrl+Alt

+L/R

Rotates the pattern 90Æ.

Fit Size Changes the size of the pattern so that

it exactly matches the used area.

Text Adds text to the pattern.

Table 3.2: The Edit Menu

Item Short-

Cut

Btn Description

Tools Ctrl+Alt

+T

Show or hide the tool palette.

Colors Ctrl+Alt

+C

Show or hide the color palette.

Table 3.3: The Show Menu

11
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Item Short-

Cut

Btn Description

Patterns Changes the deafult size of the

cells/stitches of the patterns. Any new

patterns that are created will be shown

with this size.

Colors Changes the number of colors that are

visible on the color palette. This option

is also available by right clicking in the

Color Palette window.

Language Changes the language used by the pro-

gram. At the time of writing the

alternatives are English, Spanish and

Swedish, but we intend to add more

languages as soon as we can �nd some-

one who is willing to help us with the

translations. You can perform this

translation yourself. See Chapter 4 for

more details.

Please note that this manual is only

available in English, and the help �les

only in English and Swedish.

Hints Ctrl+H Show or hide the popup hints that oc-

cure when you move the mouse over

something. Even if the hints are turned

o� you can see the longer hint text at

the bottom of the pattern window.

Tip of

the Day

Show or hide the Tip of the Day win-

dow when the program starts.

Table 3.4: The Options Menu

Item Short-

Cut

Btn Description

Show All Shows all patterns, including any who

have been minimized.

Window

names

If you have several patterns opened and

quickly want to �nd one of them you

can click on its name in this list.

Table 3.5: The Windows Menu

12
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Item Short-

Cut

Btn Description

Rescan

Library

Rescans the library directories

Table 3.6: The Library Menu

Item Short-

Cut

Btn Description

Index F1 Opens the help �le.

Tip of

the Day

Shows the Tip of the Day window.

About Shows some information about the pro-

gram. From the dialog window that

is shown you can email to the cre-

ators of the program and visit the pro-

grams home-page if your system sup-

ports these functions.

WWW If your computer has Interner capabil-

ity this program will take you to Stitch

homepage where you always can �nd

the latest version of the program as well

as patterns.

Table 3.7: The Help Menu

13
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3.2 The Pattern Library

The Pattern Library is something that it takes while to appreciate fully.

Basically it is a clipboard where you can place patterns that you want to

have quick access to. A typical example is if you want to make a large table

cloth which is mostly made up by a number of di�erent 
owers. You can

then place these 
owers in the library and then easily create as many of

them as you want. Another example is when you want to write a lot of text

on a pattern and does not want to use the capabilities that Stitch provides

for this purpose (see the tutorial called "Text on the Pattern" in Chapter

9 for more information.) You can then place each letter in the library and

thus have a very quick access to them. The Pattern Library is covered in

more detail in the tutorials.

3.3 The Tool Palette

The Tool Palette (Figure 3.2) contains the tools that you use to draw your

pattern with. It is divided into two parts. The upper part contains the

actual tools, while the lower contain the types of stitches that the program

supports. The two most important items on the tool palette is undoubtly

the pen tool which is used to draw stitches and the cross stitch stitch type.

Both of these are indicated (selected) in Figure 3.2. All of the tools and

their usage is described in the tutorials below.

Figure 3.2: The Tool Palette

3.4 The Color Palette

The Color Palette (Figure 3.3) is used to select the color that you should

draw with. To select a color just click on it. You can also change the number

of colors that the palette shows by right clicking on the palette.

If you need a color that is not presently at the palette, double click on

a color that you do not need for the moment to open the Color Properties

dialog (Figure 3.4). This dialog allows you to select another color that should

be on the palette instead of the one that you double clicked on. Stitch has

around four hundered prede�ned colors, but if you really need a color that

it does not o�er you can click on the "Select Color" button that allows you

to select an arbitary color. Please note however that it is not necessarily a

good idea to create new colors since these will lack some information such

as for example DMC and Anchor numbers.

14
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Color Palette!Pattern
Locating colors
Colors!Locating

Figure 3.3: The Color Palette

The number behind the color name (303 in Figure 3.4) might need some

explanation. This number has nothing to do with any thread makers num-

bers. Instead it is an internal ID that is necessary since the names of the

colors are di�erent in di�erent languages. If you want to see for example

a colors DMC number you have to select the appropriate sort order. The

identi�er for the selected thread maker will then be put in front of the name.

One �nal point before we continue. In Figure 3.3 you can see that some

of the colors has symbols in the corner. This is because Stitch doesn't have

one symbol for each color but assigns the symbols as needed during runtime.

You can read more about symbols in Chapter 7.

As you can see in Figure 3.3 the color palette actually contains two

di�erent palettes. So far we have only covered the "Basic Palette". The

second palette, the "Pattern Palette" works somewhat di�erently. If you

have a pattern open and click on the Get button then this palette is �lled

with all the colors from that patter. This palette can thus be a real time

saver if you are working with several patters which all should have the same

palette.

The Locate buttons are used to locate a particular color in a pattern.

To locate a color you select it in one of the palettes and then click on the

Locate First button (the binoculars). If the color exists in the pattern,

then this cell will be indicated by black cells on the border as is shown in

Figure 3.5. The Locate First button always starts searching in the top

left corner of the pattern. If you want to �nd the next instance of the color

15
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Colors!Finding similar
Similar colors
Pattern window

Grid
Support Lines

Figure 3.4: The Color Properties Dialog

you can use the Locate Next button (the arrow) instead.

Figure 3.5: Locating a Color

The Similar button (the three crayons) sorts the colors of the "Pattern

Palette" according to their similarity to the currently selected color.

These last two functions Locate and Similar might seem somewhat

strange at �rst, but can be very useful for example when trying to reduce

the number of colors in a pattern. This is a common problem with imported

patterns, and is covered in more detail in Chapter 8

3.5 The Pattern Window

The Pattern Window (the largest window in Figure 3.1)is undoubetly the

most important part of Stitch since it is here that you actually create you

patterns. To paint is simple: just select the appropriate tool from the Tool

Palette and the color you want to use from the Color Palette and click on

the cell where you want the stitch placed. You can have several patterns

open at the same time.

The buttons at the top of the window has these functions:

These four buttons changes the setting of the grid. The �rst

button turns it o� completely. If you want to see more of the pattern this
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Draw mode
Zooming
Cell size
Full screen mode
Example patterns

can be a good option since the grid lines take up suprisingly much space.

The second shows the basic grid (thin lines between each cell). The third

and fourth gives a help grid with �ve or ten cells between each thicker line.

These three buttons sets the draw mode of the pattern. The �rst

shows the cells with a sort of pseudo cross stiches, the second �lls the whole

cell, and the third uses symbols.

This button opens the Pattern Properties dialog where you can set the

size of the pattern as well as other settings.

These two buttons zooms in and out of the pattern. Users of versions

prior to 1.2 should note that it is now possible to zoom even further out, so

that you can see a quite large pattern. This is especially eÆcient if you also

turn o� the the grid.

This button opens the pattern in full screen mode. The mode does not

work perfectly, but might be worth a try if you need to see a larger part of

the pattern.

This button opens the online help for the window.

Below the pattern you can see three gray areas that gives information.

The �rst shows if the pattern has been changed or not since it was last saved.

The second area shows the size of the pattern.

The third area is used to show hints about the functions of various parts

of the program. Try for example to look at this area while moving the mouse

over the Color Palette. You will see the names of the colors as you move

the mouse.

You can also right click on the pattern to get a menu with some of the

most common commands from the Edit menu.

3.6 Example Patterns

Apart from the patterns in the library Stitch comes with a number of ex-

ample patterns located in the directory Patterns which in turn is located in

the directory where Stitch is installed. Some of these patterns are shown in

the next pages.
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Figure 3.6: Big Sun { this is a quite large converted image. A detail of how

it looks like in symbol mode is shown in Figure 3.7

Figure 3.7: Big Sun in symbol mode (detail)
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Figure 3.8: Blackwork { how to make this pattern is covered in Chapter 6

Figure 3.9: Dragon { those who has visited Stitch homepage has probably

seen his brother

19
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Chapter 4

Language Support

Stitch is multilingual, meaning that it can display (almost) all texts within

the program1 in di�erent languages. Currently English, Spanish (thanks

Carmen and Kerrie) and Swedish is supported. If you want to have access

to Stitch in another language, do not dispair though, as the next section

will show it is quite possible (although quite tedious) to translate Stitch

into other languages.

4.1 Translating Stitch

To translate Stitch into another language follow these steps:

1. Rename the �le Custom.ini to cus.ini

2. Each line of cus.ini has this format: XXX=YYY. You have to translate

everything to the right of the = (that is the YYY part) to the language

you are interested in. For example "Hello=Hello old chap" would

become "Hello=Hej gamle v�an" in Swedish

There are a number of special things you need to think about when

you do so:

� On some lines there are strange sequences starting with a % such

as %s or %.f These have to be present in your translation since

they are exchanged for other strings during runtime. For the

moment they also has to be in the same order as in the original

�le. We hope to get around this little problem as soon as possible.

� An & in the string means that the next character should be the

"hot key" for the menu item or button. The hot key is the un-

derlined character that you see on menu items and that you can

use as a shortcut to the command. For example &Custom will

1This manual is only available in English, and the help �les (which isn't very helpful) is

only available in English and Swedish. Since Stitch is still evolving it is simply too much

work to maintain several di�erent versions of the documentation.
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underline the C. You do not have to put out the & if you do not

want to.

� Some of the hint texts contain two di�erent texts separated by

a vertical bar, for example "No linesjNo lines at all". In this

case everyting to the left of the vertical bar is the "short hint",

that is the text that occures directly over the button or whatever.

Everything on the right is the "long hint" that is shown at the

bottom of the pattern window.

3. In the Options menu select LanguagejCustom to get your newly trans-

lated language.

4. If you want to make us happy you can send us2 the cus.ini �le so

that we can make it available to others. This was how the Spanish

translation was made.

2
henrikbe@dsv.su.se
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Chapter 5

Tutorial - A First Design

This tutorial will walk you through a �rst design. It introduces most of the

basics of Stitch so that you should be able to create your own designs after

doing it. The task is to create the design shown in Figure 5.1.

Figure 5.1: Example Pattern

5.1 Setting the Attributes of the Pattern

When you �rst creates a new pattern it is created with a default width and

height (100 stitches each) and a white background. However, the pattern

we are to create now is much smaller than this, and since a large part of it is

white it might also be a good idea to use another background color so that

we see what we are doing. To change these settings, click on the pattern

properties button (Figure 5.2) which is located at the top of the Pattern

Window to open the Pattern Properties dialog (Figure 5.3). In your case

the large grid to the right is probably empty since it shows what colors are

used in the pattern and how many stitches there are of each color.

The Pattern Properties dialog is used to set various attributes of the

pattern. In this case we should set the width and height of the pattern. To
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Midpoint markers
Pattern!Background
Color properties dialog
Pattern properties
dialog Figure 5.2: The pattern properties button

Figure 5.3: The pattern properties dialog

do this you can either enter the number into the appropriate edit box, or

use the arrows that are attached to the edit boxes to change the values. For

this pattern both the width and the height should be 25 sitches.1 If you

want to you can also set the midpoint markers (arrows) here.

We should also change the background since the pattern contains quite a

lot of white and it is diÆcult to see a white stitch on a white background. Do

do this, double click on the white area marked background. This will open

the Color Properties dialog (Figure 5.4). We will get back to this dialog in

a moment, so just select the color that you want to use as the background

from the list at the top of the dialog. A good choice for the background color

is for example blue or brown. When you have changed the color name, click

on the Ok button to close the dialog and return to the Pattern Properties

dialog.

While we have the pattern properties dialog open we might as well look

at the other pages of it too. The �rst of these, the "Information" page,

allows you to enter information about yourself such as for example your

email address or copyright information. The last page, the "Description"

page, contains a text area where you can write a description of the pattern.

Enter whatever you like on these two pages and then close the dialog.

1It might be a good idea to set these values a little higher than necessary to get some

extra room. You can always use the Fit Size command on the Edit menu to get the

exact size just before you save the pattern.
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Figure 5.4: The color properties dialog

5.2 Drawing the Border

Now its time to start drawing. The �rst step here is to select the right tools.

For this purpose we want to use the pen tool, and we want to draw cross

stitches, so make sure that the buttons that represent these two tools are

selected on the tool palette (Figure 5.5).

Figure 5.5: The tool palette

When you have picked the right tools it is time to select the color you

want to use. In this case it should be one called "Gray, Pewter". Try to

�nd this color on the color palette. If you look at the bottom of the pattern

window as you move the mouse pointer over the colors of the color palette

you will see the name of each color as you move the mouse over it. Most

likely you will not �nd the color that you are looking for among the colors

of the palette, since it is not a part of the standard palette. If you do �nd

it, just click on it to select it. If you do not �nd it, select a color that you

do not need at the moment and double click on it. This will open the color

properties dialog (Figure 5.4) where you can select the colors that is to be

visible on the palette.

The color properties dialog is used for several di�erent tasks, but the

functionality of it is the same in all cases. At the top you have a list of all

colors that Stitch can use. To select a particular color click on the arrow

besides the name and a list of colors will drop down, when you have found
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the color you want, just click on it in this list. In this case we want to have

the one called "Gray, Pewter". Below the names of the colors there are

three areas that give information about how the color will look in various

circumstances. The two to the right will be covered in the next tutorial, so

ignore them for the moment, and look at the one to the left. This shows how

the color looks like. If you do not know the name of the color you wantyou

can double click on this panel. This opens a dialog where you can chose

exactly the color you want.

Below the colored area there are two buttons marked Select and Delete.

These are used to select an arbitary color and remove colors that are not a

part of Stitch standard set of colors. However, since Stitch uses around 400

di�erent colors there should really never be any need for you to de�ne any

new colors. Select thus works exactly as double clicking on the colored panel

above the button. Note that the Delete button is not available in Figure

5.4. This is because the selected color is part of Stitch standard palette

and can not be deleted. You can only delete colors that you have de�ned

yourself.

The �nal line of buttons are the standard dialog buttons that closes the

window with or witout applying the new color that you have selected plus

the help button tha you can use to get some more information about the

dialog. Since we want the color that we have selected to be a part of the

palette, click on the Ok button.

You will now see that the color that you double clicked on has been

replaced with the one you selected in the Color Properties dialog. It has

also become the current color, that is, the color that you will use to draw

with. Now, draw the outline of the �gure using this color. Then select

the black color from the palette and draw the eyes and mouth of the ghost.

When you are done the �gure should look like Figure 13. It is not important

that the �gure looks exactly as Figure 5.6, but it is very important that the

�gure is closed, so before continuing, please check that there are no gaps in

the border of the �gure.

Figure 5.6: The �gure after drawing the outline and the face
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If you made any mistakes you can remove them either by selecting one

of the eraser tools (button four and �ve in Figure 5.5)or by right clicking on

the stitch that you want to remove. Note, however, that using the "Clear

Stitch" tool or right clicking only removes the kind of stitch that currently

is selected. If you want to remove the whole cell you have to use the "Clear

Cell" tool. Since we have not used any other type of Stitch than the cross

stitch yet, this will not be a problem, and the two tools will work in the

same way.

5.3 Using the Fill Tool

Now it is time to draw the interior. Select the white color and try to �ll

the ghost. Quite tedious is it not? Well, if you look at the top part of the

Tool Palette (Figure 5.7) you will see that there are a number of other tools

available to us. The �rst of these, the selection tool, is primarily used when

copying parts of a pattern, and will be covered in more detail in a another

tutorial. The same goes for the two last tools, the exchange color tool, and

the pick color tool. There are also the two aforementioned tools for removing

stitches, but we are not interested in that for the moment. However, the

Fill tool (the third button from the left) might be of interest to us.

Figure 5.7: The tools of the Tool Palette

The �ll tool is used to �ll large areas with the same color. Although it

works with all stitch types it is recommended that you only use it with the

cross stitch since it is more or less impossible to predict the results otherwise.

Select the �ll tool, and click somwhere inside the �gure on a stitch that is

part of the background. If your �gure did not contain any gaps you will see

that it is now �lled with white. Otherwise most of your pattern will now be

white. If the latter alternative should be the case use the Undo command to

go back one step and try to �x the gap before you try the �ll tool again.

When you are done with the �ll tool go back to the pen tool and apply

any �nishing touches that you feel are necessary before saving the pattern

again.

5.4 Printing the Pattern

If your computer has a printer you can now print your �rst pattern. To do

this click on the Print button or select the Print item on the File menu.
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This will open the Print dialog2 (Figure 5.8).

Figure 5.8: The Print Dialog

Now, printing is quite easy. Simply select the information that you want

to include on the chart and then click on the Print button.

If you want to print a particular page you can do so by selecting it in

the preview and clicking the right mouse button. This opens a menu where

you can select "Print Selected Page".

Before you press the Print button, ensure that the printer mode is Sym-

bols. This will print the pattern with symbols for each color just as it is

done in, for example, cross stitch magazines.

When you close the Print dialog you will most likely see that some of the

colors of the Color Palette has gotten small symbols at the lower right corner.

These symbols correspond to the symbols that are printed (if you did not

change to another printer mode). If you change the draw mode of the pattern

to the symbol mode, by clicking on the symbol mode button (the last button

in Figure 5.9), you will see that the symbols of the screen corresponds to the

ones on the printed pattern. However, we will talk more about these symbols

in another tutorial, so for the time being, congratulations on creating you

�rst pattern with Stitch.

Figure 5.9: The Symbol Mode Button

2Those who have used Stitch 1.0 and 1.1 will notice that the preview looks di�erent.

Among other things it is much smaller now. This was done to speed up the preview, and

to allow the printing of single pages.
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Chapter 6

Tutorial - Outline Stitches or

Blackwork

In the �rst tutorial we looked at the basics of Stitch, or how to make cross

stitch designs. However, Stitch can use other types of stitches than the cross

stitch, and there is much left to explore in the editor as well. In this tutorial

we will look into outline stitches and also how to copy and transform parts

of a pattern. The design we are going to create is shown in Figure 6.1.

Figure 6.1: A Blackwork Design

If we look at the design we see that it:

� Is created entirely with outline stitches

� Only uses one color

� Contains repetitions of the same pattern

6.1 Creating the Building Block

Before we can proceed we need a new pattern to draw on, so select FilejNew.

You do not have to change the size or set the background color if you do

not want to.
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Now look at the Tool Palette (Figure 6.2). As you can see it has four

pens available for drawing outline Stitches (the four buttons to the right

in the lower line of buttons). One that draws horizontal stitches, one that

draws vertical stitches, and two that draws diagonal1 stitches. The reason

why we have four pens instead of the necessary one or two is that it is much

easier to draw with more specialised pens. Especially the diagonal stitches

was hard to place right using a single tool.

In this tutorial we will use all four of these pens. We will also use the

copy command and its variants quite a lot.

Using the outline stitch pens, draw the part of the design that is shown

in Figure 6.3 at the top left corner of the pattern (leave some room to the

left though so that we can draw the rest of the pattern too). This is our

basic building block that we will use to create the whole pattern. If you

make a mistake, do not worry, just right click on the stitch that you want

to remove. You will notice however, that you can only remove stitches of

the same type that you are drawing with in this way. If you want to remove

any other stitches you will have to select another stitch type or use one of

the eraser tools.

Figure 6.3: The �rst part of the pattern

6.2 Copying the Building Block

Now we need a copy of this pattern. To create a copy of the pattern use the

steps below:

� Select the part of the design that you want to copy by chosing the

selection tool (the arrow in the upper left part of the tool palette) and

use it to mark the area that you want to copy. Move the curser to

1Note that drawing two dioganal stitches in a cell is not the same as drawing a cross

stitch even if the two stitches are of the same color.
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the upper left corner of the rectangle you wish to select. Press the

left button down and drag the curser to the lower right corner of the

rectangle you wish to select, and release the left mouse button.

� Copy the pattern that you have marked. This can be done in three

ways: you can click on the copy button, you can select the Copy option

from the Edit menu, or you can use the keybord shortcut Ctrl-C.

� Now paste the copied pattern. Again this can be done in three dif-

ferent ways: you can click on the paste button, you can select the

Paste option from the Edit menu or you can use the keyboard shot-

cut Ctrl-V. When you do this the pattern that was previously marked

will appear on the pattern.

� Move the new �gure by moving the curser inside the highlighted area,

pressing the left button on the mouse down, and dragging it to the

location you want to place the copy on.

6.3 Rotating and Placing the Copy

As you can see the copy looks exactly as Figure 6.3. This is not what we

want though, since we would rather that it looked like Figure 6.4 instead.

To achieve this right click on the copy to get a menu of commands that you

can apply to the copy (Figure 6.5).

Figure 6.4: The �rst part copied and 
ipped

For the time being it is the last two commands that are interesting: Flip

and Rotate. To get the pattern in Figure 6.4 you will need to apply two

commands. First you have to rotate it to the right, and then you have to


ip it horizontally.

After you have done this you will probably have to move the copy again

to place it on the correct position.

You can place a copy on the pattern by double clicking on it or right

clicking and selecting Paste or Paste Inclusive. The di�erence between

these two options is that Paste will completely replace the area with the

copy. This means that any part of the copy that is part of the background

will be background. Paste Inclusive on the other hand will only replace

those stitches that are actually a part of the copy. In this case you have to

use Paste Inclusive since otherwise some of the stitches will disappear.
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Figure 6.5: The commands that you can apply to the copy

If you do not want to place the copy you can use the Cancel command

to remove it.

Figure 6.6: Combining the two �rst parts

Draw the remaining part of the middle. Either manually or by copying

it and either 
ipping it or rotating it so that it looks like Figure 6.7. A

quarter of the pattern is now �nished. The rest is just a question about

copying the pattern and rotating it one step each time, so we will leave this

as an exercise for the reader.

Once you have created your design, remember to save it.
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Figure 6.7: One quarter �nished
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Chapter 7

Tutorial - Using Symbols

In the �rst tutorial we looked at creating basic patterns. We also looked

very brie
y at the symbols that the program can use instead of colors when

you are creating your pattern. However, there are more to learn about

these symbols, and this short tutorial will teach you the basics. The most

important thing to know about the symbols that Stitch uses is that there

are two sets of symbols. To you as a user they look the same, but it is

important to know the di�erence between them. The symbols that you

saw in the �rst tutorial all belonged to the group of dynamically allocated

symbols. These are symbols that Stitch assigns to the colors as soon as it

notices that there is a need for a symbol for a color. You as a user has no

control over these symbols, they are managed by Stitch, and a color might

get a di�erent symbol each time you run Stitch.

The reason for this is that Stitch has more than four hundered prede�ned

colors, and you as a user can create as many more as you like. There is simply

no way for us to create a unique symbol for each of these colors, at least not

a unique symbol that is easy to distinquise from all other symbols. However,

it is sometimes necessary to be able to ensure that a particular color always

uses the same symbol, in particular if one is working with a large pattern

that is divided into several parts.

Because of this Stitch also has statically allocated symbols, that is, sym-

bols that you as the user can assign to a particular color.

7.1 Dynamic Symbols

Before we continue with the tutorial you have to have a "clean" instance of

Stitch. That is, if you have drawn anything you migh need to restart the

program before we continue. The important points are that you should have

a blank pattern, and that no symbols are shown on the color palette.

Assuming that you have not changed the basic palette (it does not matter

if you have) you should have the following four colors at the top of the color

palette: Red, Green, Blue, Medium and Black. Now, switch to symbol

mode (by clicking on the Symbol Mode button) and draw according to the
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directions below.

1. Draw a vertical line of cross stitches with the Red color. This line

should be positioned at the fourth column.

2. Draw another vertical line of stitches using the Green color. This time

you should do it in the third position.

3. Do the same with Blue, Medium and Black, each time moving one

step to the left.

When you are done your pattern and the color palette should look like

Figure 7.1. Now, save this pattern. When you have done this, close down

Stitch, and start it again. Then load the pattern that you just saved. If

you followed the instructions you should now see that the pattern and the

color palette looks like Figure 7.2 instead1. Note that the symbols are in

another order now. This is due to that these symbols are allocated by Stitch

as needed, and the order that they where needed where di�erent between

these two images.

Figure 7.1: The pattern and the color palette before restarting

Figure 7.2: The pattern and the color palette after restarting

If you open another pattern, and swithches to symbol mode and draws

using these colors you will see that they stay the same. Once allocated the

symbols are locked to a particular color until you close down Stitch.

1This screenshot was made before the second palette was introduced.
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7.2 Static Symbols

Now, suppose that it is really important that a color always has a speci�c

symbol (for example if you are creating a larger pattern from several di�erent

parts). In this case you can chose to assign a particular symbol to that color.

To do this, double click on the color that you want to set the symbol for in

the color palette. This will open the Color Properties dialog that we used

in the �rst tutorial to �nd a color that was not present at the color palette.

As you can see in Figure 7.3 there are two squares below the name of the

color. The �rst of these shows the color. The second show the symbol that

the color will use in symbol mode. Since this color does not have a symbol

assigned to it the second square is blank. This is true even if the color has

a dynamic symbol assigned to it. The symbol only shows up here if it is

statically assigned.

Figure 7.3: The color properties dialog

To set the symbol you need to double click on the square. This will bring

up the Color-Symbol mapping dialog (Figure 7.4) where you can assign the

symbol by selecting it and clicking on the Ok button. If you want to remove

a symbol you of course click on the Remove button instead. When you

return to the Color Properties dialog you will see that the gray square to

the right of the colored square will have a synmbol in it.

If you open the Color-Symbol mapping dialog again you will see that

the symbol you chose now has a border around it with the color that the

symbol is assigned to.

7.3 Symbols for Other Kinds of Stitches

So far we have dealt only with symbols for the cross stitch. However, the

kind of border stitches covered in the previous tutorial also needs to be
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Figure 7.4: The Color-Symbol Mapping Dialog

displayed with symbols if they are to be printed in black and white. Just

like symbols for cross stitches there are two versions of this kind of stitches,

dynamic and static, and there really is just a few things you need to know

about them except that what you already know about cross stitch symbols:

� There are much fewer of these symbols

� Dynamically allocated symbols for stitches other than the cross stitch

is not printed in the pattern legend (statically allocated are printed)

� You assign them using the drop down list shown in Figure 7.4

� Several colors can have the same symbol

Several of these are of course limitations that we intend to remove as

soon as possible, but it is important to know about them.
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Tutorial - Importing an

Image

The patterns created so far has been fairly small and simple and has thus

been easy to create manually. Now, suppose that you have a friend that is

crazy about something and you want to take this funny picture you have

found on the internet and create a framed picture for him or her. To trans-

form this image into a pattern that you can use when stitching would be a

very tedious task, in particular since you might have to rearrage the palette

several times to get enough colors. Would it not be great if Stitch could take

this image and create the pattern for you. Well, actually it can do this1,

and this is the topic of this tutorial.

8.1 A First Attempt at Importing an Image

For our �rst attemt at importing an image we will use the image shown in

Figure 8.1.

Figure 8.1: An example image to be imported

To import this image select the menu FilejImportjImage. This will open

1Some users has asked for functionality to import real cross stitch patterns, either from

other programs or directly from paper. Presently this is not possible since we do not have

access to the �le structure of other programs, or have enough knowledge about OCR. If

we ever get enough time to look into the problem the functionality might be added, but

don't hold your breath.
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Import image dialog a �le dialog where you can select what image you want to import. This image

is called but.wmf and is located in the directoy PatternsjTutorial which in

turn is located in the directory where stitch is installed. Select the �le and

click on the Open button to open the Import Image dialog (Figure 8.2).

Figure 8.2: Import Image Dialog

This dialog is used to control the import process. To the right the picture

is shown exactly as it will be imported. To the left are controls that allow

you to tailore the import, and it is here we will concentrate our attention.

At the top there are a checkbox that says Background. If this checkbox

is checked the color shown in the box below the checkbox will be removed

from the image and not included in the import phase. If you double click on

the box that shows the color you can chose another background color. You

can also click on the Top Left button to select the color of the top left pixel

of the image as the background, an option that works remarkably often.

Since the butter
ys wing extends to the top left of the picture this button

will not work in this case though. To set the background manually double

click on the colored box. This will open a standard color dialog where you

can select the background color. In the case of the butter
y this should be

pure white. Also make sure that theBackground checkbox is checked.

Below the background settings there are settings to control the size of

the image. There are two edit boxes with arrows at the end where you can

change the size directly. Above these there are a checkbox marked Aspect

Fit that controls how these edit boxes act. If the checkbox is checked, and

one of the size values are changed, then the other value will also change so

that the relationship between the vertical and the horizontal size remains

the same. Below the edit boxes there is a button labeled Original Size,

and if you click on this the image will return to its original size.

So, play with the size settings, and when you have fond one that you
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Reducing the no.\ of
colors

Colors!Reducing no.\ of

think is suitable klick on the Ok button to import the image. Remember

though that the numbers corresponds to stitches, and an image that is a

100x100 stitches is, if not a large, then at least a reasonable sized pattern.

This wasn't so diÆcult was it? Fortunately for us the image was more

or less perfect for the task. It contained only two colors and was in WMF

format which meant that we could easily change it size without losing details.

In many other cases we are not so lucky as we will soon see.

8.2 Importing a More Complex Image

Now, although importing images such as the one in the previous section is a

good feature (some of the best images in the library has been imported in this

way) it is probably more interesting to look at more complex images. The

image used in this section is not really that complex, a color photograph

would have been a better example, but would probably have lead to an

unreadable tutorial.

Figure 8.3: An example image to be imported

The image is also located in the Patterns|Tutorial directory and called

redroses.gif (Figure 8.3). Import this image in the same way as we did above.

Remember to check the background checkbox and select the background

(this time the Top Left button works �ne). We would not want to stitch

the whole white background.

The main problem with this image is that it contains too many colors.

We will therefore concentrate on reducing the number of colors to a more

reasonable level. Fortunately there are two tools that we have not more

than touched upon yet that can be of help to us now: the exchange color

tool, and the pick color tool (Figure 8.4).

Figure 8.4: the Exchange Color and Pick Color Tools

To use the exchange color tool you select it in the tool palette and

then selects the color that you want in the color palette. Then you click

on a stitch of a color that you want to change into the color that you have

selected. You can also use this tool to remove a color. This works in the
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Pattern palette same way. Simply select the exchange tool and click on the color that you

want to remove completely from the pattern.

The pick color tool is used to select a color directly from the pattern.

Simply select this tool, and click on a stitch that has the color that you want

and it will be selected.

It is relatively easy to reduce the number of colors to perhaps 20-30

with these two tools, but then it becomes more and more diÆcult. The

remaining colors all start to look so similar, and for a large image it can be

almost impossible to �nd them even in the symbol mode.

Up to version 1.1 of Stitch there really wasn't any more the program

could do for you in this situation. To improve the situation version 1.2

introduced the Pattern Palette discussed in Chapter 3.4 (the right palette

in Figure 8.5). With this palette you can use the Locate and Similar

Colors commands to help reducing the number of colors.

Figure 8.5: The Pattern Palette
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Chapter 9

Tutorial - Putting Text on

the Pattern

Something that is quite common on patterns is text. However, creating

patterns with texts can be quite tedious, in particular if the text is long and

you have to create every letter by hand. Fortunately Stitch has at least two

ways of helping you with creating texts. The �rst most straightforward is

of course to use an alpahabet pattern where you copy and paste each letter

to where they should be. This is a perfect use for the library by the way.

A couple of such patterns are available among the examples shipped with

the program, and more can be found on the programs homepage (http:

//www.dsv.su.se/~henrikbe/stitch). However, Stitch also has another

way of adding text.

To use this function, click on the last item in the Edit menu: Text. This

brings up a window where you can write the text you want to have on the

pattern (Figure 9.1).

Figure 9.1: The Text Window

There really is not too much to say about this window, so this tutorial

is a bit on the short side. Basically you write the text you want to have on
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the pattern in the text area, change the font and color using the buttons,

and press the Ok button when you are done. The only thing you need to

really consider is the line above the text area that tells you how much space

the text will use.
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Chapter 10

Tutorial - Using the Library

The last function to be covered in this series of tutorials is the Pattern

Library (Figure 10.1). This is a collection of shortcuts to other, ususally

smaller, patterns that you can use in your design.

Figure 10.1: The Pattern Library

Using library patterns is simple. Each button on the library correspond

to a pattern. To add add pattern to your design you just click on its button.

To simplify browsing the libary is divided into sections. Each section is

represented by a tab, and to change section you click on the tab.

10.1 Creating a pattern using the Library

We will now create the simple patter shown in Figure 10.2.

As you can see in Figure 10.2 the pattern actually consists of two �gures.

One of a small boy, and one hart repeated three times, so now we just have

to create this pattern.

To do this is simple, just locate each part in the library (the boy is in

the Misc section) and click on it. This will load the pattern and paste a

copy of it in your own pattern. This copy can be treated just as any other

copy, for example rotated if you want to do that.

When you have created the pattern go about and explore the patterns

in the library, and remember, they are only examples. You can easily add

your own patterns to the library as we will soon see.
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Library!Adding
patterns

Adding patterns to
the library

Generate Glyph

Library!Generating
glyphs

Library!Rescanning
Library!Editing
patterns

Figure 10.2: A Simple Pattern

10.2 Adding Patterns to the Library

The patterns in the library may not be particularly interesting, depending

on your interests. They are only ment as examples after all. So, before the

library becomes really useful you have to put some patterns into the library.

To add a pattern to the library is simple. The only thing you have to do

is to save the pattern in a directoy located under the directory library which

in turn is located in the directory where Stitch is installed. Each directory

in the library directory corresponds to a tab in the library. If you want to

have a image for the pattern on its button in the Library you can achieve

this by creating a bitmap image that is 16x16 pixels with the same name as

the pattern and placing this image in the same directory as the pattern. The

easiest way to do this is to right click on the button and selecting Generate

Glyph1

To see your new pattern in the library you also has to use the Library|

Rescan library command.

10.3 Editing Patterns in the Library

Editing a pattern in the library is even simpler than adding a pattern to it.

Simply open the pattern just as you would with any other pattern and edit

it. When you save the pattern all future usage of this pattern will include

your changes. A quick way to open the pattern is to right click on the button

and selecting the Edit Pattern command.

1The word Glyph might need an explanation. It is simply a small image.
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Licence Agreement

Appendix { Licence

Agreement

This is a contract. By installing this software you accept all the terms and

conditions of this agreement.

The term software in this licence agreement refer to the program Stitch

and all accompanying material such as manuals, help�les etc. The terms we

and us refers to the development team of Stitch.

Please read this agreement carefully. At the end, you will be asked to

accept this agreement and continue to install or, if you do not wish to accept

this agreement, to decline this agreement, in which case you will not be able

to use the software. Failure to follow the agreement might result in that we

take legal actions to protect our rights.

Upon your acceptance of this agreement, we grant to you a nonexclusive

license to the use and re-distribute as many copies of the software as you

like, provided that you agree to the following:

Distribution of the software

Stitch may be distributed freely as long as nothing is changed in it, and

nothing except media costs and package is charged for it.

Copyright

The software is owned by us, and its structure, organisation and code are

our property. The software is also protected by Swedish Copyright Law and

International Treaties.

Restrictions to usage

You agree not to modify, adapt, reverse engineer, decompile, disassemble or

otherwise attempt to discover the source code of the software.
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No Warranty

The software is being delivered to you AS IS and we make no warranty

as to its use or performance. WE DO NOT AND CANNOT WARRANT

THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING

THE SOFTWARE OR DOCUMENTATION, AND WE MAKE NO WAR-

RANTIES, EXPRESS OR IMPLIED, AS TO NONINFRINGEMENT OF

THIRD PARTY RIGHTS, MERCHANTABILITY, OR FITNESS FOR ANY

PARTICULAR PURPOSE. IN NO EVENT WILL WE BE LIABLE TO

YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAM-

AGES, INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN

IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAM-

AGES, OR FOR ANY CLAIM BY ANY THIRD PARTY.

Termination of agreement

This agreement shall automatically terminate upon failure by you to comply

with its terms in which case you must remove the software from your system

immediately.
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